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1 Introduction 

This Step-by-step training guide relates to the Great Belt Fixed link, which is located 

between the Danish islands Funen and Zealand (see Figure 1.1).   

 

 
 
Figure 1.1 Map showing the Great Belt area, which is located between Funen and Zealand, 

Denmark 

 

1.1 Background 

In 1989 the construction of an 18 km long link across the Great Belt in the Danish waters 

was initiated. The Great Belt Fixed link consists of a road suspension bridge and railway 

tunnel between Zealand and the islet Sprogø, as well as a box girder bridge between 

Sprogø and Funen. 
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Figure 1.2 The suspension bridge, known as the Eastern Bridge, is a part of the Great Belt Link 

connection and located between Zealand and Sprogø 

 

As the establishment of causeways and bridge piers in connection with the Great Belt 

Link construction work inevitably would have increased the flow resistance in the Great 

Belt and thereby have affected the supply of saline, oxygen rich water from the North Sea 

into the Baltic Sea, it was decided to carry out compensation dredging of the sea bottom 

thereby equalising the flow resistance. Furthermore, it was foreseen that the 

compensation dredging activities, together with other dredging operations connected with 

the construction work, were likely to cause significant environmental impact caused by the 

spill of dredged material.  

 

The Great Belt Sediment Plume Model, SPM, was developed to serve as a tool for the 

planning and monitoring of the dredging operations taking place in connection with the 

implementation of the fixed link. 

 

The SPM model was applied in the planning and monitoring of the various dredging 

operations in connection with the Link, and before and during the construction extensive 

measurement campaigns were conducted. 

 

The water density in Kattegat is larger than the density of the Baltic Sea. This means that 

if the water level is the same at the north and the south boundary, the water will actually 

flow to the south, but the MIKE 21 Flow model will simulate no flow. The difference 

between the water densities at the south and north boundary depends on the 

hydrodynamics of the previous period. Thus, this must be considered when calibrating the 

model. 

 

During time periods where the difference in water level between Kattegat and the Baltic 

Sea is small or in shallow areas in shelter of the main current in the Belt, the current is 

dominated by interactions between wind and friction forces. The current may vary 

significantly in time and space according to local wind phenomena, such as sudden 

changes in speed and direction. This is a difficult current field to describe within the MIKE 

21 model, and tracks of floats placed in areas or periods like these are difficult to 

reproduce. 
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Figure 1.3 Spilled sediment during construction of pier base in the case of south-going currents. 

The image view is directed towards south-west 

 

1.2 Objective 

The objective of this Step-by-step training guide is to set up a Particle Tracking MIKE 21 

Flow Model with flexible mesh (MIKE 21 Flow Model FM, Particle Tracking Module) for 

the Great Belt area from scratch and to calibrate the model to a satisfactory level.  

 

MIKE 21 is a one-layer hydrodynamic model and thus the model does not include the 

vertical density gradients. The water in the Great Belt is stratified most of the time. In 

some periods the two layer effects are so important that the flow field cannot be described 

satisfactorily within a one-layer model. 

 

With the restrictions of the model in mind, the focus in this example is on particle tracking 

and it is assumed that you are familiar with setting up a hydrodynamic MIKE 21 Flow 

Model FM. If not please refer to the Step-by-step guide, which can be accessed via the 

MIKE Zero Documentation Index in the start menu: 

 

MIKE 21 & MIKE 3 Flow Model FM, Hydrodynamic Module, Step-by-Step Training Guide 

 

Attempts have been made to make this exercise as realistic as possible although some 

shortcuts have been made with respect to the data input. This mainly relates to quality 

assurance and pre-processing of raw data to bring it into a format readily accepted by the 

MIKE Zero software. Depending on the amount and quality of the data sets this can be a 

tedious, time consuming but indispensable process. In this example the ‘raw’ data have 

been provided as ASCII text files. Moreover, the hydrodynamic model could be calibrated 

to a higher extent than in this example. 
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The files used in this Step-by-step training guide are a part of the installation. You can 

install the examples from the MIKE Zero start page. 

 

Please note that all future references made in this Step-by-step guide to files in the 

examples are made relative to the main folders holding the examples. 

 

User Guides and Manuals can be accessed via the MIKE Zero Documentation Index in 

the start menu. 

 

If you are already familiar with importing data into MIKE Zero format files, you do not have 

to generate all the MIKE Zero input parameters yourself from the included raw data. All 

the MIKE Zero input parameter files required to run the example are included and the 

simulation can be initiated right away. 
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2 Creating the MIKE Zero Project 

2.1 The Role of the MIKE Zero Project in this Example 

MIKE Zero enhances the ability to control and organise information related to almost all 

kinds of engineering studies including model simulations.  

 

A MIKE Zero project is a collection of files, positioned in one or several folders recursively 

under a folder where the overall project file is positioned. For example, a DHI project will 

typically hold separate folders for measured data, model input, model results and 

documentation.  

 

By selecting a template that fits the aim of the study, the logical organisation of the project 

folders helps streamline the work by adding informative, intuitive and helpful features. 

However, in this example only the directly relevant files for the study are given as part of 

the installation and the work flow is described in the present manual. 

 

The MIKE Zero project will in this case mainly be useful for getting an overview of the 

available data and quick access to the files. It is thus decided to create the MIKE Zero 

project file, not by using any of the pre-defined templates, but by using the option ‘Project 

from Folder’. This option creates a project where all existing files within the folder and 

subfolders are included in the project by default, maintaining the folder structure. 

 

The creation and use of MIKE Zero projects are explained in larger detail in the MIKE 

Zero Step-by-step guide, which can be accessed via the MIKE Zero Documentation Index 

in the start menu: 

 

MIKE Zero, Project Oriented Water Modelling, Step-by-Step Training Guide 

 

2.2 Creating the Project File 

To create a new project file showing the files supplied with the installation, open the MIKE 

Zero shell and click File→New→Project from Folder…, see Figure 2.1. 

 

In the New Project from Folder dialogue, select the folder that contains the installed 

example and name the project. You can specify the Project Name anyway you like. In this 

case it is named ‘Great Belt Project – Particle Tracking’, see Figure 2.2. 
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Figure 2.1 Selecting to create a new project from folder 

 

 

 
 
Figure 2.2 Specifying the root folder and project name for a new MIKE Zero project  

 

The next dialogue lists the subfolders and files within the root folder and subfolders to be 

included in the MIKE Zero project, see Figure 2.3. All files and folders are selected by 

default, but you have the option to unselect some before creating the project. 
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Figure 2.3 List of files and folders in root folder for MIKE Zero project 

 

Press Finish and the project will now automatically be created with the selected files and 

folders. The project will be opened and shown in the Project Explorer in the MIKE Zero 

shell. By using the Project Explorer and File Explorer you can get an overview of all the 

files and folders contained in the project, see Figure 2.4 and Figure 2.5. 

 

 
 
Figure 2.4 Project Explorer view showing the folders and some of the files supplied for the 

example by the installation. 
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Figure 2.5 File Explorer view showing the file types and the time series (dfs0) files supplied for 

the example by the installation 

 

It is also possible to include the pdf-file containing the present Step-by-step guide in the 

project. This will enable a quick access to the description of the example.  

 

Right-click the project in Project Explorer, select ‘Add existing file…’ and select the 

document MIKE_FM_PT_Step_By_Step.pdf located in the manuals directory. Select the 

Copy Mode to create short-cut to the pdf-file. The pdf-file can now be easily accessed 

through the Project Explorer, see Figure 2.6. 

 

 
 
Figure 2.6 Shortcut to pdf-file included in the MIKE Zero project 
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3 Creating the Computational Mesh 

Creation of the mesh file is a very important task in the modelling process. 

 

The mesh file couples water depths with different positions and contains the following 

information: 

 

1. Computational Grid 

2. Water Depths 

3. Boundary Information 

 

Creation of the mesh requires an xyz file for positions of land-boundaries and an xyz file 

that couples geographical positions with water depths. A bathymetry in dfs2 format can 

also be used as an alternative to an xyz file with water depths. 

 

Creation of the computational mesh typically requires numerous modifications of the data 

set, so instead of explaining every mouse click in this phase, the main considerations and 

methods are explained in the Step-by-step guide, which can be accessed via the MIKE 

Zero Documentation Index in the start menu: 

 

MIKE 21 & MIKE 3 Flow Model FM, Hydrodynamic Module, Step-by-Step Training Guide 

 

When creating the computational mesh you should work with the mdf-file, which contains 

information about the settings for the mesh. The focus in this example is on Particle 

Tracking, so the necessary bathymetry information (here given as xyz files and an old 

MIKE 21 bathymetry), the mdf-file and the mesh-file are already supplied with the 

example, so that the training time can be spent on specific Particle Tracking subjects. 

 

The mesh, which is used in the example, is shown in Figure 3.1 and Figure 3.2 shows a 

graphical presentation of the mesh as it can be displayed with MIKE Animator. 

 

The applied coordinate system is the SBF system, which is a local Transverse Mercator 

projection especially created for the construction of the Great Belt link. 
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Figure 3.1 The Great Belt computational mesh as it can be presented with the Data Viewer tool 

 

 
 
Figure 3.2 The Great Belt computational mesh as it can be presented with the MIKE Animator 

tool 
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4 Creating the Input Parameters to the MIKE 21 Flow Model FM 

Before the MIKE 21 Flow Model FM can be set up, the input data to the model must be 

generated from the data collected.  

 

The following data have been applied for this example: 

 

1. Water levels at four stations (SBF02, SBF11, SBF13 and SBF14) in the Great Belt 

area 

2. Current measurements at station SBF07 and SBF09 

3. Wind measurements from Sprogø (SBF08) 

The measured raw data from November 1990 are included in the folder: 

 

.\MIKE_21\FlowModel_FM\PT\GreatBelt\Data\Measurements\ASCII 

 

A map showing the positions of the monitoring stations is shown in Figure 4.1. The 

coordinates are given in Table 4.1. 

 

 
Table 4.1 Measurements stations in the Great Belt Area. Projection SBF (ED50) 

 

Station Easting [m] Northing [m] Measurement 

SBF-02 490435 6159807 Water level 

SBF-07 495476 6131135 Current 

SBF-08 500106 6134282 Wind 

SBF-09 503449 6132231 Current 

SBF-11 502045 6112259 Water level 

SBF-13 517943 6120092 Water level 

SBF-14 483443 6090708 Water level 
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Figure 4.1 A map of the Great Belt showing the positions of monitoring stations: 

WLR: Water level recordings 
ADCP: Current measurements (Acoustic Doppler Current Profiler) 
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Furthermore, various float tracks have been conducted during 27 November 1990. These 

measurements will be used for the calibration of the Particle Tracking model. 

We have chosen to start the simulation period at 21/11 1990 18:00 and end it at 28/11 

1990 00:00. The period prior to the float track measurements can then be used for 

calibration of the hydrodynamic model. 

4.1 Generating Hydrodynamic Boundary Data 

The water levels at the various monitoring stations in the Great Belt area have been 

measured. To simulate the flow in the area, measured water levels south and north of the 

belt area are used. 

 

The computational domain contains 5 open boundaries, which are located in the vicinity of 

a water level measuring station, see Figure 4.2. 

 

 
 
Figure 4.2 Position of boundaries and related measuring stations 

 

The extension of the model area is limited and the water levels along the individual 

boundaries are not expected to have significant variation, which will influence the results. 

Therefore, it is assumed that it is sufficient to use a constant water level along each 

boundary. 
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4.1.1 Importing measured water levels to time series file 

The water levels were measured by soundings. The results were saved in text files with 

four columns (see Figure 4.3): 

 

Column 1: Date and time in UTC (Number of seconds from 1 January 1970 at  

00:00:00, the time step is 0.5 hours) 

Column 2:  Water level (m) DNN 

Column 3:  Soundings (m/s) 

Column 4:  Reference target number 

 

 
 
Figure 4.3 Example of measurements: water level recordings from Station SBF02 in November 

1990. 

 

To simplify the pre-processing of the data, all columns are imported initially in time series 

format, but it will only be column 2 with the water levels that will be used.  

 

Open the Time Series Editor in MIKE Zero (File→New→File→Time Series), see Figure 

4.4. Select the ASCII template and open the text file ‘SBF02_901101.txt’.  

 

Please note that time series must have equidistant time steps in MIKE 21 & MIKE 3 Flow 

Model FM. This means that if the raw data have time gaps without measurements, the 

gaps in the raw data must be filled before importing them. 
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Figure 4.4 Starting the Time Series Editor in MIKE Zero 

 

 

 
 
Figure 4.5 Time Series Editor Import Template 

 



 MIKE 21 Flow Model FM 

16 Particle Tracking Module - © DHI A/S 

On the time series property page change the time description to ‘Equidistant Calendar 

Axis’, set the start time to 1 November 1990 at 00:00:00 and the time step to 30 minutes. 

Set the remaining parameters as shown in Figure 4.5 and press OK. 

 

Then right-click on the generated data, select properties and change the title and type of 

item 2 to ‘Water Level’, see Figure 4.6. Save the data in the time series file 

WL_SBF02.dfs0. 

 

The resulting time series can be seen in Figure 4.7. 

 

 
 
Figure 4.6 Time Series Properties 

 

 

 
 
Figure 4.7 Time Series Editor with imported Water Levels from Station SBF02 
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Repeat the steps above to import the remaining water level recordings into time series 

format. For the coming processing, the measured water levels have been collected in a 

file named ‘Waterlevel_Nov1990.dfs0’. 

 

4.1.2 Filtering time series 

To obtain a smooth variation of water levels, the measured water level recordings may be 

low pass filtered. This will ensure a better performance of the model. 

 

The time series of measured water levels may contain delete values where no 

measurements were available. Before filtering the data these delete values must be 

replaced by real values. In this case the delete values are omitted from the time series by 

interpolating the data using the Time Series Editor (Tools→Interpolation) and saved in the 

file ‘Waterlevel_Nov1990_I.dfs0’. 

 

To filter the time series use the MIKE 21 Tool FFT Filtering of Time Series. 

 

Open the MIKE 21 Toolbox in MIKE Zero (File→New→File), see Figure 4.8. 

 

 
 
Figure 4.8 Selecting the MIKE 21 Toolbox in MIKE Zero 

 

Select the tool FFT Filtering of Time series in the Waves group, see Figure 4.9. 
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Figure 4.9 Selecting the FFT Filtering of Time Series tool in MIKE 21 Toolbox 

 

Press the New button and follow the dialogues. Select the interpolated time series file as 

the input file. In the next dialogue box, define the frequency range as shown in Figure 

4.10. The maximum frequency of interest is set to 9.259e-005 Hz, corresponding to 3 

hours.  

 

 
 
Figure 4.10 Specifying frequency range in FFT Filtering of Time Series tool 

 

Save the data as ‘WL_Boundary.dfs0’.  

 

Now you are ready to use the values in this file as boundary conditions in the simulation. 
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To make a plot of the water level time series open the Plot Composer in MIKE Zero 

(File→New→File→Plot Composer), see Figure 4.11. Select ‘plot’ → ‘insert a new plot 

object’ and select ‘Time Series Plot’ (see Figure 4.12).  

 

 
 
Figure 4.11 Starting the Plot Composer in MIKE Zero 

 

 

 
 
Figure 4.12 Insert a new Plot Object as Time Series in the Plot Composer 

 

Right click on the plot area and select properties. Add the actual time series file to the Plot 

Composer by clicking   and selecting the file, see Figure 4.13. It is possible to add 

more than one time series to the same plot. In the ‘Time Series Plot Properties’ dialogue it 

is possible to change some of the properties for the plot, such a colours, etc. (see Figure 

4.14). 
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Figure 4.13 Selection of time series files in the Plot Composer 

 

 

 
 
Figure 4.14 Plot Composer Time Series Plot Properties dialogue for selecting time series files and 

adjusting scales, curves, etc. 
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Figure 4.15 shows the measured water levels during the simulation period for the four 

measuring stations. 

 

 
 
Figure 4.15 The four boundary water level time series plotted with Plot Composer 

 

4.2 Generate Hydrodynamic Forcings 

The measurements of wind should also be entered in MIKE Zero format. 

 

4.2.1 Wind forcing 

Wind recordings from Sprogø (SBF08) will form the wind forcing as time series constant 

in space. The recordings were saved in text files with three columns (see Figure 4.16): 

 

Column 1: Date and time in UTC (Number of seconds from 1 January 1970 at  

00:00:00, the time step is 3.0 hours) 

Column 2:  Wind direction (deg N) at 10 metres above surface 

Column 3:  Wind speed (m/s) at 10 metres above surface  

 

 
 
Figure 4.16 ASCII file with wind speed and direction from Sprogø 
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Load the time series editor and import the ASCII file ‘SBF08_901101.txt’ with equidistant 

calendar axis as described in Section 4.1.1. Save the file in ‘wind.dfs0’. Time series of the 

wind speed and direction can be illustrated with the Time Series Direction Plot in Plot 

Composer, see Figure 4.17. 

 

 
 
Figure 4.17 Wind speed and direction at Sprogø during simulation period as it can be illustrated in 

the Plot Composer with the Time Series Direction Plot template 

 

4.3 Generate Float Track Source 

Float tracking measurements were conducted in the area south of Sprogø in an area with 

water depths varying between 15 and 20 metres, from 8 am to 12.30 pm on 27 November 

1990.  

 

The floats were placed at a depth of 2.5 meters. A listing of the geographic positions is 

given in Table 4.2 and a plot is shown in Figure 4.18. 
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Table 4.2 Measured float track positions in time 

 

Float number Time GMT Easting  

(m) 

Northing (m) Duration  

(s) 

1 

 

 

 

07:59:25 

09:25:13 

10:52:14 

11:56:47 

502951 

502623 

502185 

501586 

6130519 

6129991 

6129660 

6129519 14242 

2 

 

 

 

08:09:06 

09:31:04 

10:59:17 

12:15:10 

501785 

501416 

500562 

499627 

6130495 

6129843 

6129327 

6129285 14764 

3 

 

 

 

08:13:53 

09:35:32 

11:04:27 

12:21:49 

500984 

500412 

499359 

498453 

6130507 

6129812 

6129394 

6129400 14876 

4 

 

 

 

08:19:49 

09:40:29 

11:08:52 

12:28:00 

499987 

499300 

498327 

497370 

6130499 

6129789 

6129369 

6129442 14891 

5 

 

 

08:25:54 

09:44:31 

12:32:29 

498967 

498402 

496799 

6130493 

6129623 

6129173 14795 

7 

 

 

 

08:31:12 

09:48:07 

11:14:39 

12:38:43 

497941 

497645 

496983 

496175 

6130495 

6129730 

6129409 

6129702 14851 

8 

 

08:36:05 

09:52:43 

496974 

496848 

6130501 

6130213 4598 

10 

 

09:43:04 

12:44:34 

495687 

495401 

6130508 

6130299 

 

8986 

 

 

Each of the floats were released at a certain position and at a certain time. To model this 

in the particle tracking model, a time series file was generated with 8 items - each item 

describing the source of one of the floats. The position of the source will be defined by a 

fixed location. 
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Figure 4.18 Position of the floats in the Great Belt on 27 November 1990. 

A listing of the geographic positions is given in Table 4.2 

 

Only one particle is to be applied per float track, thus to simplify the setup, the time step of 

the time series file is set to the overall time step. A dummy value of 100 kg/s is used for 

the magnitude at the given time step, and in the remaining time the magnitude is 0. The 

generated time series file will look similar to the one shown in Figure 4.19.  

 

 
 
Figure 4.19 Time series file describing the source of floats 
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5 Setup of the MIKE 21 Flow Model FM 

5.1 Specifications for the MIKE 21 Flow Model FM 

We are now ready to create the specification file for the Particle Tracking modelling using 

the Great Belt mesh generated in Chapter 2 and the input parameters generated in 

Chapter 4. 

 

The Particle Tracking technique uses a discrete approach in the calculations with 

information from the overall time step. This implies that the calculation of particle tracks 

can be applied in a decoupled mode without losing any accuracy in the results. 

 

Running a simulation in decoupled mode can significantly reduce the computation time. If 

the basic flow information from a hydrodynamic simulation is saved in a number of special 

decoupling output files, it is possible to re-run the simulation in a decoupled mode, where 

instead of calculating the flow information it is read from the output files. Hence, it is 

decided to calibrate the hydrodynamic model alone, before setting up a decoupled model 

for the particle tracking simulations. The setup of the first calibration simulation for the 

hydrodynamic module consists of the parameters shown in Table 5.1. 

 
Table 5.1 Specifications for the calibration simulation of HD 

 

Parameter Value 

Specification File HD_Run.m21fm 

Mesh and Bathymetry GreatBelt.mesh    4442 Nodes 

Simulation Period 1990-11-21 18:00 – 1990-11-28 00:00 (~6 days) 

Time Step Interval 600 s 

No. of Time Steps 900 

HD: Solution Technique Low order, fast algorithm 

Minimum time step: 0.01 s 

Maximum time step: 600 s 

Critical CFL number: 0.8 

HD: Flood and Dry Standard flood and dry 

HD: Initial Conditions Surface elevation: 0.4 m 

HD: Wind Varying in time, constant in domain: wind_basic.dfs0 

Soft start: 21600 s 

HD: Wind Friction Constant: 0.0025  

HD: Boundary Conditions Specified level 

Type 0 data: WL_Boundary.dfs0 

Include Coriolis and wind correction 

Soft start: 21600 s from 0.4 m 

HD: Eddy Viscosity Smagorinsky formulation, Constant 0.28  

HD: Resistance Manning number. Constant value 28 m1/3/s  

HD: Decoupling Include, time step frequency: 1 

HD: Result Files HD_out.dfsu, HD_out.dfs0, (+ Decoupled files) 

CPU Simulation Time About 3 minutes using 4 threads with a 70 Ghz PC, 8 GB 

RAM 
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The setup of the first calibration simulation for the particle tracking module consists of the 

parameters shown in Table 5.2. 

 
Table 5.2 Specifications for the first calibration simulation of PT 

 

Parameter Value 

Specification File PT_Run1.m21fm 

Mesh and Bathymetry GreatBelt.mesh    4442 Nodes 

Simulation Period 1990-11-21 18:00 – 1990-11-28 00:00 (~6 days) 

Module Selection Particle Tracking 

Hydrodynamics Decoupled results from HD : 

Run_HD_DecouplingFlux.dfsu 

Run_HD_DecouplingArea.dfsu 

PT: Number of Classes 8 (one per float track) 

PT: Number of Sources 8 

Track_Release_South27.dfs0 

PT: Decay Not included 

PT: Settling Not included 

PT: Dispersion Not included 

PT: Erosion Not included 

PT: Drift profile Use raw data from hydrodynamics 

PT: Result Files PT_1.dfsu, PT_1.XML 

CPU Simulation Time A few seconds 

 

In the following screen dumps, the individual input pages are shown and a short 

description is provided. 

 

Additional information about the Particle Tracking Module can be found in the User Guide, 

which can be accessed via the MIKE Zero Documentation Index in the start menu: 

 

MIKE 21 Flow Model FM, Particle Tracking Module, User Guide 

 

5.2 Basic Parameters 

Specify the bathymetry and mesh file GreatBelt.mesh in the ‘Domain’ dialogue, see 

Figure 5.1. The projection zone has already been specified in the mesh as SBF.  
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Figure 5.1 MIKE 21 Flow Model FM: Specify Domain 

 

In the mesh file, each boundary has been given a code, see Figure 5.2. In this example 

the boundaries has Code 2 to Code 6, starting at the north boundary and moving anti-

clockwise around the mesh. Rename the boundary ‘Code 2’ to ‘North’, the boundary 

codes 3 and 4 to ‘West1’ and ‘West2’, the boundary code 5 to ‘South’ and the boundary 

code 6 to ‘East’ in the ‘Domain’ dialogue box under ‘Boundary names’, see Figure 5.2.  

 

 
 
Figure 5.2 M21 Flow Model FM: Renaming boundaries 

 

Specify the overall time step to 600 s in the ‘Time’ dialogue. The time step range must be 

specified to 900 time steps in order to simulate a total period of 6 days and 6 hours. Set 

the simulation start date to 21-11-1990 18:00:00, see Figure 5.3. 
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Figure 5.3 MIKE 21 Flow Model FM: Simulation period 

 

 

In this example only the Hydrodynamic Module will be used, see Figure 5.4.  

 

 
 
Figure 5.4 MIKE 21 Flow Model FM: Module Selection 
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5.3 Hydrodynamic Module 

The shallow water equations are solved using ‘Low order, fast algorithm’ for both time 

integration and space integration, see Figure 5.5. 

 

The minimum time step is set to 0.01 to ensure that the CFL number always is lower than 

the critical CFL number, here defined as 0.8. The maximum time step is set to the overall 

time step of 600 s. 

 

 
 
Figure 5.5 MIKE 21 Flow Model FM, Hydrodynamic Module: Solution Technique 

 

In this case the Flood and Dry function is included, see Figure 5.6. You just have to set 

the Drying depth to 0.005 m and the Flooding depth to 0.05 m. The Wetting depth should 

be 0.1 m. These are the default values. 

 

Unfortunately, the densities at the boundaries for the domain were not measured during 

the float track period. As no boundary data exist it is not possible to simulate the density 

variation in the domain to any realistic values. Thus, it is decided to omit the influence of 

any possible density variations. As the density variation is not to be taken into account in 

this example the density should be specified as ‘Barotropic’ in the ‘Density’ dialogue, see 

Figure 5.7. 
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Figure 5.6 MIKE 21 Flow Model FM, Hydrodynamic Module: Flood and Dry 

 

 

 
 
Figure 5.7 MIKE 21 Flow Model FM, Hydrodynamic Module: Density specification 

 

The default setting for the Horizontal Eddy Viscosity is a Smagorinsky formulation with a 

coefficient of 0.28, see Figure 5.8.  
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Figure 5.8 MIKE 21 Flow Model FM, Hydrodynamic Module: Eddy Viscosity (Horizontal) 

 

The Bed Resistance will be given as a constant Manning number of 28 m1/3/s, see Figure 

5.9.  

 

 
 
Figure 5.9 MIKE 21 Flow Model FM, Hydrodynamic Module: Bed Resistance 

 

Coriolis forcing is always included in real applications. Only for laboratory type of 

simulations Coriolis is most often ignored, see Figure 5.10. 
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Figure 5.10 MIKE 21 Flow Model FM, Hydrodynamic Module: Coriolis Forcing 

 

To use the generated wind time series specify it as ‘Variable in time, constant in domain’ 

in the ‘Wind Forcing’ Dialogue, and locate the time series wind_basic.dfs0.  

 

Please note that an easy way to see the wind data file is to simply click  in the 

‘Wind Forcing’ dialogue, see Figure 5.11. 

 

 
 
Figure 5.11 MIKE 21 Flow Model FM, Hydrodynamic Module: Wind Forcing 
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Furthermore, when you run a simulation it is good practice to use a soft start interval. In 

this case 21600 s is suggested. The soft start interval is a period at the beginning of a 

simulation where the effect of the wind does not take full effect. At the beginning of the 

soft start period, the effect of the specified Wind Forcing is zero and then it increases 

gradually until it has full effect on the model at the end of the soft start interval period. 

Specify the Wind Friction type as ‘Constant’ and use the value 0.0025 for the Wind 

Friction, see Figure 5.12. The wind friction value, which has been set to a higher value 

than the default value as field measurements of the drag coefficient collected over 

enclosed areas, such as the Great Belt area, indicates that the drag coefficient is larger 

here than in the open sea.  

 

 
 
Figure 5.12 MIKE 21 Flow Model FM, Hydrodynamic Module: Wind Friction 

 

Please note that in this example the following parameters are not included: 

 

• Ice Coverage 

• Tidal Potential 

• Precipitation-Evaporation 

• Infiltration 

• Wave Radiation 

• Sources 

• Structures 

 

and their respective dialogue pages are not considered further. 

 

Now you should check the boundary conditions at the simulation start time to estimate the 

initial surface level specified in the ‘Initial Conditions’ dialogue see Figure 5.13. In this 

case we will use a surface elevation level of 0.4 m, which is close to the measured value 

for all the boundaries at the start of the simulation. 

 



 MIKE 21 Flow Model FM 

34 Particle Tracking Module - © DHI A/S 

 
 
Figure 5.13 MIKE 21 Flow Model FM, Hydrodynamic Module: Initial Conditions 

 

In the ‘Boundary Conditions’ dialogue, the boundary conditions should be specified for the 

boundary names, which were denoted in the ‘Domain’ dialogue (Figure 5.2). There are 5 

boundaries; North, West1, West2, South and East.  

 

In this example the boundary type is ‘Specified Level’ (Water Level), because only Water 

Level measurements are available, see Chapter 3. ‘Specified Level’ means that the Water 

Levels are forced at the boundaries, and the discharge across the boundary is unknown 

and estimated during simulation.  

 

The boundary format must be set as ‘Varying in time, constant along boundary’ in order to 

specify the boundary as a time series file (dfs0). 

 

Click  and select the appropriate data file (e.g. WL_Boundary.dfs0) in the Open 

File window that appears, see Figure 5.14. 
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Figure 5.14 MIKE 21 Flow Model FM, Hydrodynamic Module: Boundary Selecting file and item for 

boundary 

 

Select item 1 in the time series file for the North boundary as this item contains the filtered 

water levels from measuring station SBF02 (WL2). For the boundaries West1 and West2 

select item 4 (WL14), for the South boundary select item 2 (WL11) and for the East 

boundary select item 4 (WL13).  

 

For the soft start you should use linear variation with the same time interval of 21600 s as 

in the ‘Wind Forcing’ dialogue (Figure 5.11) and a reference value of 0.4 m corresponding 

to the initial value. See Figure 5.15. Also all the boundaries should include Coriolis and 

wind correction. 

 

Please note that an easy way to see the boundary data file is to simply click  in 

the ‘Boundary’ dialogue. 
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Figure 5.15 MIKE 21 Flow Model FM, Hydrodynamic Module: Boundary Conditions for the West 

Boundary are specified as constant along the boundary: WL_Boundary.dfs0, item 
WL14 

 

The first simulation of MIKE 21 Flow Model FM is for calibrating the hydrodynamic model 

alone. Thus, to save computation time in the simulation, the generation of decoupled files 

for future particle tracking simulations is not considered here. Once the flow model has 

been calibrated, files for subsequent decoupled model simulations can be generated as 

described in Section 5.4.3.  

 

Specify one output as an area series (2D) and specify the resulting output file name as 

HD_out.dfsu, see Figure 5.16. Make sure the required disk space is available on the hard 

disk. Reduce the output size for the area series to a reasonable amount by selecting an 

output frequency of 3600 s, which is a reasonable output frequency for a tidal simulation. 

As our time step is 600 s then the specified output frequency is 3600/600 = 6. As default, 

the full area is selected. 

 

Also specify an output file as point series at the positions of the monitoring stations 

SBF07 and SBF09, see Figure 5.17. Save every time step and use discrete values as 

interpolation type. You might consider saving other time series from neighbouring points, 

so that you can see how much the results vary in the area near the monitoring station.  
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Figure 5.16 MIKE 21 Flow Model FM, Hydrodynamic Model: Output of area series  

 

 

 
 
Figure 5.17 MIKE 21 Flow Model FM, Hydrodynamic Model: Output of point series  
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Pick the parameters to include in the output file as shown in Figure 5.18. 

 

 
 
Figure 5.18  MIKE 21 Flow Model FM: Output Parameters 

 

Now you are ready to run the MIKE 21 Flow Model FM, simulating the hydrodynamic 

conditions for the Great Belt Area. 

 

The specification file for this example has already been made, and it can be found in the 

Examples folder: 

 
.\MIKE_21\FlowModel_FM\PT\GreatBelt\HD_Calibration\HD_Run.m21fm 

 

5.4 HD Model Calibration 

5.4.1 Measured values 

In order to calibrate the model some measurements are required inside the model 

domain.  

 

The hydrodynamic model is calibrated by comparing current measurements from the two 

monitoring stations SBF07 and SBF09, positioned south-west and south-east of Sprogø, 

respectively (see Figure 4.1). Vertical current profiles were obtained by Acoustic Doppler 

Current Profilers (ADCPs) mounted on the sea bed. 

 

The ADCP recordings were saved in text files with columns. The first column showed date 

and time in UTC (Number of seconds from 1 January 1970 at 00:00:00 with a 0.5-hour 

time step). The next columns showed measurements from a number of levels in the water 

column. Each measurement (bin) was represented by four columns (east, north and 

vertical current component + error value).  
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The levels in the water column are described by  

 

SBF07:  Water depth = 21.4 m DNN 

bin(i) = -19.5 + (i-1).1.0,   i=1,17 

 

SBF09: Water depth = 18.7 m DNN 

bin(i) = -16.8 + (i-1).1.0,   i=1,15 

 

The measured current data have been imported into dfs1 files. Figure 5.19 and Figure 

5.20 show the current profile (east and north component) measured on 27 November at 

stations SBF07 and SBF09, respectively. Please note that the upper part of the profile, 

which may be largely influenced by wind, is not shown in the plots.  

 

 
 
Figure 5.19  Current profiles (east and north component) measured at SBF07 

 

 

 
 
Figure 5.20  Current profiles (east and north component) measured at SBF09 
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The depth averaged values have been calculated and saved into dfs0 files. Figure 5.21 

and Figure 5.22 show the East and North components of the depth averaged current in 

station SBF07 and SBF09, respectively. During the simulation period, the current was 

predominantly towards north. 

 

 
 
Figure 5.21 Measured depth-averaged current components for SBF07 

 

 

 
 
Figure 5.22 Measured depth-averaged current components for SBF09 

 

The data files with the measured current data are included in the folder: 

 

.\MIKE_21\FlowModel_FM\PT\GreatBelt\Data\Measurements 

 

During the float track period on 27 November, the current was weak. From 8-10 am the 

current was weak with a mean north component of 0.04 m/s to the south. From 10 to 12 

AM the current decreased further and turned from south to a weak north-going current at 

SBF 07, which resulted in the very curved float tracks shown in Figure 4.18. 
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5.4.2 Compare model result and measured values 

An example of the simulated flow field for the area around Sprogø is shown in Figure 

5.23. 

 

 
 
Figure 5.23 Simulated flow field in the area around Sprogø during a period with north-going 

currents 

 

Use the Plot Composer to plot the simulated current velocities at the positions for SBF07 

and SBF09. 

 

For this example, Plot Composer files have already been made. The files are found in the 

following folder: 

 

.\MIKE_21\FlowModel_FM\PT\GreatBelt\HD_Calibration\Plots 

 

Open the files CurrentSpeed_CompareSBF07.plc and CurrentSpeed_CompareSBF09.plc 

to see a comparison of measurements and model output of currents at the two measuring 

stations, respectively.  

 

If your simulation is successful, plots as shown in Figure 5.24 and Figure 5.25 will appear. 

The float track period is indicated by vertical lines by the end of the simulation. 
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Figure 5.24 Comparison of measurements and model output of current at SBF07. 

Dotted line: depth-averaged measured values, Solid line: simulation 
Upper: North composant, Lower: East composant 

 

 

 

 
 
Figure 5.25 Comparison of measurements and model output at SBF09. 

Dotted line: depth-averaged measured values, Solid line: simulation 
Upper: North composant, Lower: East composant 
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The comparisons between measured and calculated current velocities indicate that the 

simulated north composant of the current is close to the measured whereas the east 

composant shows too little variation compared to measurements. The results from the 

float track period on 27 November are close to the measured values. However it should 

be noticed that this is a period with low current speeds in general.  

 

The density in Kattegat is larger than the density of the Baltic Sea. This means that if the 

water level at the north and south boundary is the same, the water will actually flow to the 

south, but the model will simulate no flow. The difference between the densities on the 

south and north boundary depends on the hydrodynamics of the previous period. Thus, 

the model simulation in general underestimates south-going currents and overestimates 

north-going currents.  

 

Unfortunately, actual measurements of the densities on the boundaries did not take place 

during the float track period and have therefore not been included in the simulation. 

However, salinity measurements were made at stations SBF07 and SBF09 at various 

depths ranging from 7.0 m to 19.2 m. The measured salinity values for the upper and 

lower depth levels are shown in Figure 5.26. 

 

 
 
Figure 5.26 Measured salinity at stations SBF07 and SBF09. 

Full thick black line: salinity at upper level (7.2 m), SBF07 
Full thin blue line: salinity at lower level (19.2 m), SBF07 
Dotted thick red line: salinity at upper level (7.0 m), SBF09 
Dotted thin green line: salinity at upper level (19.0 m), SBF09 

 

Figure 5.26 shows that some stratification exists in the area. In general the salinity values 

in the upper layer are less that the salinity layers in the lower layer, but with no major 

differences between stations SBF07 and SBF09. However, during the float track period 

on 27 November the salinity at the lower level at station SBF09 was significantly lower 

than at the lower level at station SBF07. This indicates that additional currents due to 

density gradients between the two stations were influencing the track of the floats. 

 

Another influence that the presence of stratification induces is the Coriolis force. In the 

lower layer the current is changing from north to south as a result of the tidal variations. 

When the current is changing direction to south-going, the water in the upper layer will 

flow towards west as a result of the Coriolis force, forcing the water in the lower layer to 

flow towards east. When the north-south current decelerates, the flow towards west in the 

upper layer will decrease, forcing the lower layer to flow to the west. This phenomenon is 

shown in Figure 5.19.  



 MIKE 21 Flow Model FM 

44 Particle Tracking Module - © DHI A/S 

 

The above mentioned factors indicate that the current pattern in the present domain 

cannot be described in sufficient detail by a two-dimensional flow model. However, 

despite the many reservations that can be said about the validity of the results and level 

of calibration of the hydrodynamic model, it is assumed that the accuracy of the 

hydrodynamic simulation is adequate for the hydrodynamic conditions to be used in the 

Particle Tracking simulations. Therefore, for the hydrodynamic results we will not calibrate 

further. 

 

5.4.3 Generate decoupled model data 

The first simulation showed that the hydrodynamic results need no further calibration. Yet, 

it can save time in calibration runs of the particle tracking module, if the basic flow 

information is read from a file instead of calculating the flow information during the 

simulation. This is possible when running a simulation in decoupled mode. 

 

First, you need to generate the decoupling data (if you have not done so already).  

 

 
 
Figure 5.27 MIKE 21 Flow Model FM, Hydrodynamic Module: Decoupling specifications 

 

The decoupled data for use in future simulations are defined in the ‘Decoupling’ dialogue 

in the Hydrodynamic Module, see Figure 5.27. 

 

The decoupled data are generated and saved every 10 minutes, i.e. with a time step 

frequency of 1. The generated data files and specification file are defined by default 

names. 
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5.5 The Particle Tracking Module 

To use the decoupled file setup, generated by the HD simulation, open the generated file 

‘HD_Run_Decoupled.m21fm’, and save it under a new name.  

 

The basic domain and time parameters in the input file are already determined by the 

decoupled input data files. Include the ‘Particle Tracking Module’ in the ‘Module Selection’ 

dialogue, see Figure 5.28.  

 

 
 
Figure 5.28 MIKE 21 Flow Model FM: Module Selection 

 

The hydrodynamics are fixed and specified by the generated decoupling files, see Figure 

5.29. 

 

 
 
Figure 5.29 MIKE 21 Flow Model FM, Hydrodynamic Module: Decoupled Files 

 

The next step is to select the parameters specific for the Particle Tracking Model.  
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In the ‘Classes’ dialogue you must describe the different particle classes that are to be 

included in the calculation. A class is a group of particles with the same properties 

regarding settling, decay, dispersion and erosion. An example of a class could be silt. 

 

Specify a particle class for each of the float tracks, and describe each class separately, 

see Figure 5.30 and Figure 5.31.  

 

Set the minimum particle mass to a small value above 0. This will exclude particles with 

insignificant masses, i.e. in this example all particles with magnitude 0, shown in Figure 

4.19. The computational simulation time is proportional to the number of particles in the 

simulation, so therefore it is often a good idea to exclude the particles that have 

insignificant masses. 

 

Each class can be given a maximum particle age, corresponding to the duration of the 

measured float track as given in Table 4.2. This enables a direct comparison between 

measured and simulated float tracks. 

 

Also, when the particle exceeds the maximum age the particle is removed from the 

simulation. If the simulation contains many particles this can save a lot of simulation time. 

In this context, please note that particles released in the beginning of the simulation are 

not be considered. 

 

 
 
Figure 5.30 MIKE 21 Flow Model FM, Particle Tracking Module: Classes in setup 
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Figure 5.31 MIKE 21 Flow Model FM, Particle Tracking Module: Class specification 

 

In the ‘Sources’ dialogue you specify how the particles are entered into the simulation. In 

this example each float track is defined by a separate source, see Figure 5.32.  

 

 
 
Figure 5.32 MIKE 21 Flow Model FM, Particle Tracking Module: Sources in setup  

 

For each source you must specify the location and which particles classes that are 

released by the source. In this example the location of the source is fixed, corresponding 

to the initial position of the float track and only one particle class is included in each 

source, see Figure 5.34.  
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Figure 5.33  MIKE 21 Flow Model FM, Particle Tracking Module: Source specification 

 

 
 
Figure 5.34  MIKE 21 Flow Model FM, Particle Tracking Module: Source specification for individual 

class 
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For each particle class in the source you must specify how the particles are released. In 

this example the release of the particles is defined by the time-varying source, as 

described in Section 4.3 and the dialogue will look as in Figure 5.34. 

 

The particles simulate floats. The floats can be described as conservative, with no decay, 

erosion or settling. Therefore these effects are not included in the simulation.  

 

In order to obtain a result, which can be reproduced, the present setup does not include 

dispersion. By including dispersion the simulated float position would by random be a bit 

dislocated.  

 

The drift profile used in the simulation is based on the results from the hydrodynamic 

simulation. Optionally it is possible to consider other factors that may influence the drift 

profile and hence the influence on the particles, such as wind and bed shear stresses. 

 

For the first simulation of the particle tracking, the default type is applied, see Figure 5.35. 

 

 
 
Figure 5.35 MIKE 21 Flow Model FM, Particle Tracking Module: Drift Profile specification 

 

Finally the output must be specified. You should save the data in a particle track file. Save 

all particle locations by entering 1 for the frequency, see Figure 5.36.  
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Figure 5.36 MIKE 21 Flow Model FM, Particle Tracking Module: Output specification 

 

Furthermore, save the 2D information of the particle concentrations and hydrodynamics 

during the floats track period in another file.  

 

Now we are ready to run the MIKE 21 Flow Model FM, specified by a decoupled setup 

modelling particle tracks. 

 

The specification file for this example has already been made, and it can be found in the 

Examples folder: 

 
.\MIKE_21\FlowModel_FM\PT\GreatBelt\PT_Calibration\PT_Run1.m21fm 

 

Please note that if you experience an abnormal simulation, you should look in the log file 

to see what causes the problem. The log file is displayed in the lower simulation window 

of the main GUI, but is also accessible from a list in the file drop-down menu ‘File → 

Recent log files’. 

 

5.6 PT Model Calibration 1 

5.6.1 Measured values 

The float tracks south of Sprogø were performed in an area with water depths varying 

between 15 and 20 meters. From 8:00 to 10:00 hours the current was weak, running 

towards south with a mean velocity of 0.04 m/s. From 10:00 to 12:00 hours the current 

decreased further and turned from south to a weak north-going current, resulting in the 

very curved float tracks shown in Figure 4.18. Plots of the simulated flow pattern during 

the float track period are shown in Figure 5.37. 
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Figure 5.37 Simulated flow pattern at the beginning, middle and end of the float track period. 

Position of SBF07 and SBF09 are indicated. 
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To be able to compare the simulated float tracks with the measured, you can use the 

overlay manager. One method is to display the measured float track positions as points in 

an xyz file. Another method, which is used here, is to import the measured positions into a 

XML file, using the same format as an output file from the Particle Tracking module. The 

measurements are inserted as if the positions were simulated every 1.5 hours, see Figure 

5.38. 

 

   
 

Figure 5.38 Contents of XML file showing measured float tracks from 27 November 

 

 

The XML file has already been generated and you can find it here:  

 

\MIKE_21\FlowModel_FM\PT\GreatBelt\Data\FloatTracks\Meas_Track_South_27.XML 

 

The float tracks can be visualised by importing the XML-file into Data Viewer as a layer on 

top of a dfsu file, see Figure 5.39. 
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Figure 5.39 Measured float track visualised by a particle track overlay in the Data Viewer. Tracks 

are measured 27/11 in the period from 07:59 to 12:44 

 

5.6.2 Model results compared with measured values 

The measured and simulation float tracks are compared by importing the XML-files for 

measured and simulated data into the Data Viewer as layers, see Figure 5.40.  

 

A layer file for displaying measured and simulated float tracks has already been 

generated. To activate it you just have to open the generated file ‘PT_Run1.dfsu’ in the 

PT output directory. 

 

 
 
Figure 5.40 Particle track overlays. Blue lines: Measured, Grey lines: Simulated run 1 
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The first particle tracking simulation does not describe the float tracks well.  

 

During time periods with small water level difference between Kattegat and the Baltic Sea, 

or in shallow areas placed in the shelter of the main current in the Belt, the current is 

dominated by interactions between wind and friction forces. The current can vary 

significantly in time and space according to local wind phenomena, such as sudden 

changes in speed and direction. This is a difficult current field to describe within a 2D 

model and tracks of floats placed in areas or periods like this are difficult to reproduce. 

 

The tendency of the particles first going towards south-west and then changing direction 

towards west are indicated in the simulation by some of the floats, but the particles do not 

travel as far as expected by the measurements.  

 

This indicates that there are other factors than the raw hydrodynamics from the two-

dimensional HD simulation that need to be considered and/or that the HD simulation 

needs further calibration. 

 

5.7 PT Model Calibration 2 

5.7.1 Changed model specifications 

The floats are positioned near the water surface. This implies that the wind has an 

influence on the drift profile. That this is the case is actually observed by the ADCP 

measurements of the current profile, see Figure 5.19 and Figure 5.20. 

 

During the float track period the wind was towards south, with a wind speed of about 5 

m/s, see Figure 5.41. 

 

 
 
Figure 5.41 Wind conditions during float track period indicated by lines 

 

The second simulation with particle tracking is therefore carried out using a drift profile 

considering the bed shear profile and wind induced profile, see Figure 5.42.  
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Figure 5.42 MIKE 21 Flow Model FM, Particle Tracking Module: Selecting new drift profile 

 

The wind induced profile will have a large effect, as it will induce additional currents in the 

surface layer. The depth of influence and offshore limit are both set to 10 m as this limit is 

indicated by the measured current profiles.  

 

The wind drift factor describes the magnitude of the additional influence the wind induced 

profile will have on the flow. This factor has a common value that varies from 3 to 4 

percent of the wind speed 10 m above the water surface. Thus a wind drift factor of 0.15 

is applied in the simulation.  

 

5.7.2 Model results compared with measured values 

A layer file for displaying measured and simulated float tracks for calibration run 2 has 

already been generated. To activate it you just have to open the generated file 

‘PT_Run2.dfsu’ in the PT output directory. 

 

The measured and simulation float tracks are compared in Figure 5.43. 
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Figure 5.43 Particle track overlays. Blue lines: Measured, Red lines: Simulated run 2 

 

The length of the simulated float tracks are now of the correct magnitude, but the float 

tracks all have a too weak turn towards the west.  

 

One reason for this could be the fact that the floats were placed in an area in the lee of 

the island and a period which is difficult to describe. However, it is probably due to the fact 

that the hydrodynamic model is insufficiently calibrated and shows too poor correlation 

between measured and calculated current speeds in the eastern direction. 
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5.8 PT Model Calibration 3 

5.8.1 Changed model specifications 

The floats were positioned at 2.5 m water depth. The floats were constructed by two large 

2 x 2 m screens held together as a cross. Due to this large size, the depth of the source 

could as well have been defined as 3 m.  

 

 
 
Figure 5.44 Sketch of floating device 

 

To investigate the influence of the source depth, the third simulation with particle tracking 

is therefore carried out using a location of the source at 3 m below the water surface, see 

Figure 5.45.  

 

 
 
Figure 5.45 MIKE 21 Flow Model FM, Particle Tracking Module: Selecting new source depth 
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To compare the simulation results with the results from calibration run 2, the drift profile 

settings are set to the same as in calibration 2. 

 

5.8.2 Model results compared with measured values 

A layer file for displaying measured and simulated float tracks for calibration run 3 has 

already been generated. To activate it you just have to open the generated file 

‘PT_Run3.dfsu’ in the PT output directory. 

 

The measured and simulation float tracks are compared in Figure 5.46. 

 

 
 
Figure 5.46 Particle track overlays. Blue lines: Measured, Red lines: Simulated run 2,  

Pink dotted lines: Simulated run 3 

 

Figure 5.46 shows that by lowering the source location 0.5 m, the float tracks are turned 

more towards the west. This is due to the decreased influence of the wind drift profile. 

 

However, it seems like the hydrodynamic conditions are not sufficiently accurate to form 

the basis for the particle tracking simulations.  

 

More accurate information of the flow field can be obtained by using a hydrodynamic 

model in three dimensions, where phenomena such as variation in salinity and 

temperature in the domain are considered. 
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